
GRAPHICS ON THE WEB
CHAPTER 13

THE EXERCISES IN this chapter will provide technical lessons in 

saving graphics properly for the web. This chapter will lead you into 

the exercises and goals of Chapter 14, Know the Code. By the end 

of the section, you’ll have created a simple website based on a free 

downloaded and modified template. Developing visual content for the 

web requires you to understand how graphics will relate to the code that 

is used to display them. I have split these two foundational elements 

(graphics and code) into two chapters in order to clarify the process. 
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SCALE ON THE WEB
As explained in this section’s introduction, the web designer or net artist 
never knows the size of the browser in which the end user will be viewing the 
work. However there are standard widths common to typical online viewing 
scenarios. For the exercises in this chapter and the next, the target is a web 
browser on a laptop or desktop. So you’ll be working with the standard width 
of the total content area within the browser, which at this time of writing is 
960 pixels. A browser may be stretched open wider than 960 pixels—when 
that happens, the remaining space is commonly filled with a background 
(either an image or a color). 

Since the total width of the content is 960 pixels and screen resolution at its 
lowest is 72 pixels per inch (PPI), you can probably imagine that graphics 
tend to be small in scale when they’re saved for the web. Icons on the web, 
for instance, the ever-present social media icons, are usually composed in a 
square format as small as 32 by 32 pixels. 

Logos can be saved at any size, but a rectangular shape positioned in the top-
left corner of the website is an industry standard for commercial websites. A 
quick survey of some major sites at the time of this writing shows: the Amazon 
logo is 111 by 35 pixels, the Facebook logo is 103 by 30 pixels, and the larger 
Google logo on my Gmail page is 124 by 45 pixels—and all three are in the 
upper-left corner. So an estimate for logo sizes in the typical top-left corner 
situation might be approximately 100 to 125 pixels wide by 30 to 50 pixels tall. 
(All of this, of course, will change as standards and practices evolve).

Headers, banner images, or “sliders” (rotating images usually displayed in a 
prominent, top-level space) contain large graphics that span the width of the 
primary text column on a website. These, of course, tend to be larger than 
icons and logos. For instance, the current slider on Slate.com is 495 pixels 
wide, while the header area on Wired.com includes two columns of thumbnail 
images and large headlines (one approximately 530 pixels, the other close to 
470 pixels wide). The largest photograph on the Los Angeles Times website is 
400 by 250 pixels. Many of these sites include a sidebar area for advertising or 
additional navigation.

To create contrast and hierarchy in a compositional space, the social media 
icon should be a small, low-level element. At just 32 or 64 pixels wide, it 
makes sense that the scale of these icons is understood in relationship to a 
large header, banner, or slider image on a page (400 to 500 pixels or so). The 
difference in scale is extreme (approximately 64:450 or nearly 1:14).  
Deep/Young Anodyne Laboratories created simple splash pages for their  
REbranding project (FIGURE 13.1) to illuminate the “true nature” of a series of 

organizations. On these pages, a small logo is positioned in the center of the 
browser. It remains there, regardless of the size of the user’s browser. The 
Teletubbies page in particular demonstrates the contrast between the size of 
the animated, repeated background image and the logo in the center of the 
page.

In addition to the pixel size of the graphics, the file size is important. The 
smaller the file size, the faster the graphic will download (the shorter amount 
of time your viewer will have to wait to see your content). You’ll reduce the 
file size of your images by saving in compressed web formats, as discussed in 
the next section.

FIGURE 13.1 Deep/Young 
Anodyne Laboratories, 
REbranding, 2003. To 
help online organizations 
bridge the gap between 
themselves and their 
markets, Deep/Young 
Anodyne Laboratories was 
commissioned to REbrand 
several websites. See more 
at www.computerfinearts.
com/collection/cloninger/
rebranding/.

LINK Check out some free 
social media icon down-
loads from Noupe and 
SloDive at www.noupe.com/
freebie/50-free-social-
media-icon-sets.html and 
http://slodive.com/freebies/
awesome-social-media-
icons-web-2-0-icons/.

LINK See Brands of the 
World (www.brandsof 
theworld.com) or Seek Logo 
(www.seeklogo.com) for free 
vector files of popular logos 
that you can use for edu-
cational purposes or if you 
know your fair use rights 
protect your usage of these 
copyright protected images. 

Unlike the browser, 
which is a specific appli-
cation, the viewport is 
any frame in which a 
user views online con-
tent. This term is more 
applicable to developing 
media for networked 
screens. The exercises 
in this chapter are con-
cerned with the browser 
specifically.
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WEB IMAGE FORMATS
Every image file you save for the web needs to fit one of the file formats that 
a browser can understand and that includes compression to reduce the file 
size. For this reason, you should always save the native file (.psd or .ai, for 
instance), as well as the file formatted for the web.

There are two primary image formats used on the web, and one format that 
fell out of fashion and then suddenly regained popularity in small circles of 
net art and web meme enthusiasts. If you’re saving a photograph or an image 
of continuous tone (for instance, a file that includes gradients), use the JPG 
format. If you’re saving typography, logos, line art, or illustrations that use flat 
colors, or if you need to include transparency, use the PNG format. The GIF 
format has been largely replaced by PNG now that PNG is better supported by 
popular browsers. However, of the three, GIF is the only format that supports 
animation within the image itself.

INSERTING IMAGES INTO CODE
Once your images are properly sized and formatted, they’re ready to be 
published on the web. You might email your images or post them to a social 
media website (where your work becomes “user-generated content”). If you 
intend to insert the images on a web page, you’ll need to learn a little bit of 
code. There are two languages you should be familiar with to understand how 
to reference an image on a web page: hypertext markup language (HTML) 
and Cascading Style Sheets (CSS). When an image is inserted on a web page 
as content (a thumbnail, perhaps, that’s clickable to a larger image or a new 
page), it’s coded in an HTML file. When an image is inserted as a background 
element as part of the page’s design (either the background image on the page 
itself or a background image within a certain area of the page, like a header or 
footer), it’s coded in a CSS file. In the next chapter, you’ll learn to differentiate 
HTML and CSS code. In the exercises that follow, you’ll prepare your images 
and insert the logo as content in the HTML portion of the Soda Jerk web page. 
You’ll start the web page in this chapter and finish it in Chapter 14, Know  
the Code.

THE RETURN OF ANIMATED GIFS

FIGURE 13.2 Four still frames from The Man Who Wasn’t There (2001), an animated GIF by Gustaf Mantel.

There’s been a resurgence of animated GIFs on the web over the last couple of years. Now that many viewers have 
faster internet connections than were available in the late 1990s and early 2000s (when GIF was more popular 
than PNG), you can find large, subtly animated images that have crossed over from the once-commercial purpose 
of GIF animation (remember that “digger” image when a site was “under construction” or the animated banner 
advertisements?) to the dual worlds of net art and viral online media. See Gustaf Mantel’s Tumblr gallery  
(FIGURE 13.2) at http://iwdrm.tumblr.com/ or Giampaolo Bianconi’s editorial, Gifability, on Rhizome.org at http://
rhizome.org/editorial/2012/nov/20/gifability.
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1. View the Fayafayta website template online at  www.freewebsitetem-
plates.com/preview/firefighterwebsitetemplate. This template is robust: it 
includes multiple types of pages (FIGURE 13.4). To keep the exercise comple-
tion time to a minimum, I’ve simplified this template to a single page that 
you’ll use for the following exercises (FIGURE 13.5). Download my iteration 
of the template from the Chapter 13 downloads area on the companion 
website. Place the folder on your Desktop and name it chapter13. Open the 
folder and notice the file structure hierarchy (FIGURE 13.6).

2. Download the original size of Russell Lee’s 1939 photo Soda jerker flipping 
ice cream into malted milk shakes at www.flickr.com/photos/library_of_
congress/3548855885/sizes/o/in/set-72157618541455384/. Rename the file 
sodajerk-original.jpg and place it in the chapter13 folder.

3. Create a new folder in the chapter13 folder named psd. This folder is where 
you’ll store the native Photoshop files you use to create images for the 
website.

For a live project, you would upload JPG, PNG, or GIF image files to the 
server hosting your website. You would not upload Photoshop files to your 
server, as this file format is large and unsupported by web browsers. Keep-
ing the Photoshop files separate from the compressed files makes drag-
and-drop uploading more efficient.

4. Move modified-template.psd and sodajerk-original.jpg to the psd folder 
in the chapter13 folder (FIGURE 13.7). The soda jerk file is not in Photoshop 
format, but since it’s the original file, it makes sense to keep it in the  
psd folder. You’ll create a properly sized and cropped image from this 
original in the next exercise and save the newly compressed file to the 
images folder for use on the website.

KEY COMMAND If you’re 
using a Macintosh com-
puter, you can press the 
⌘-Tab keys to scroll 
through open applica-
tions. (Press the Tab key 
to move to the next icon.)

FIGURES 13.4 (LEFT) AND 13.5 

(RIGHT) The template on 
which these exercises are 
based and a simplified 
version of the web page for 
use in these exercises.

FIGURE 13.6 The folder 
named chapter13 is the root 
directory: it is the top-level 
folder that contains all the 
code and media needed 
to develop your website. 
Inside chapter13 are three 
folders—css, fonts, and 
images—as well as two 
files—index.html and 
modified-template.psd.

LINK  The link to complete 
information for the Lee  
photograph is on Flickr 
at www.flickr.com/
photos/library_of_con-
gress/3548855885/ and 
on the Library of Congress 
website at www.loc.gov/pic-
tures/item/fsa2000013450/
PP/.

FIGURE 13.7 The new psd 
folder includes the .psd 
template and the source 

.jpg file.

EXERCISE 

1 ORGANIZE YOUR FILE

I can’t emphasize enough how important it is to organize your files carefully 
when you’re preparing media for interactive design. The folder containing 
all of the interactive materials (code and media) is called the root directory. 
Structurally, it’s the folder with the greatest hierarchy—any other folders or 
files associated with the interactive work are organized within this directory. 
In the following chapters, you’ll start with a root directory named chapter13—
you’ll copy and modify this folder for the exercises in Chapter 14.

When building a website or an app, be consistent about where you save your 
code documents (in this case HTML and CSS files), as well as media files 
(such as JPG, PNG, GIF, MOV, or MP3). The HTML or CSS must connect to the 
media files where they exist on your hard drive. By default, the code looks 
for media files in the same location as itself (the code file), or you can specify 
a subsidiary folder, such as images. This file structure hierarchy must all be 
within the root folder. You’ll see an example of this in Exercise 4.

In this exercise, you’ll view a simplified Photoshop template based on the 
one that’s packaged with the original template download. I essentially 
stripped the file for you to make sorting through the layers easier. You’ll 
download the modified template from the companion website along with an 
image from the Library of Congress’s Flickr photostream. Then you’ll save 
and organize your files. 

WHAT YOU’LL NEED
Download the following source materials to com-
plete the exercises in this chapter:

✔✔ The modified version of the Fayafayta (fire-
fighter, with a Boston accent?) template from 
the Chapter 13 downloads area on the compan-
ion website 

✔✔ Russell Lee’s photograph (original size) from 
the companion site or from www.flickr.com/
photos/library_of_congress/3548855885/
sizes/o/in/set-72157618541455384

Place the website template folder on your hard 
drive and rename it chapter13. You’ll benefit from 
the ability to navigate through many files during 
the modification process. 

WHAT YOU’LL MAKE
In the exercises for this chapter, you’ll create the 
graphics required for the modified Soda Jerk web 
page to be made throughout Chapters 13 and 14 
(FIGURE 13.3). You’ll be working with both Adobe 
Photoshop and Adobe Dreamweaver.

FIGURE 13.3 The resulting web page is a modification of 
the template.
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EXERCISE 

2
UNDERSTAND A PHOTOSHOP  
TEMPLATE FILE

Much of what you’ll see in the Photoshop template will actually be displayed 
in the browser via code, but parts of the template will be used directly as 
images. The elements you’ll prepare in the following exercises are the back-
ground image (where you’ll substitute the soda jerk image for the firefighter) 
and the logo. However, it can be helpful to see how the designer thought 
about the page, visually, before constructing it in code. Some web designers, 
artists, and developers prefer to work with an application like Photoshop or 
Adobe Illustrator while developing a mock-up of the page. Others argue that 
creating a mock-up directly in markup (code, that is) is more efficient. I think 
this depends on your skill level with writing code, and even if you do create a 
mock-up in markup, you’ll always want to draw a rendition of your idea, even 
if it’s on paper with a pen or pencil. 

1. Open modified-template.psd in Photoshop. You may see a message 
regarding fonts used in the template that aren’t installed on your computer 
(FIGURE 13.8). Click No, as in do not update, or OK, depending on the 
message you see, as you won’t be altering the text in Photoshop.

2. Review the pixel dimensions and resolution that the template designer 
used in creating this document. Choose the Image menu > Image Size. 
You’ll see that the file resolution is 72 DPI or PPI. Near the top of the dialog 
box, you’ll see the pixel dimensions: 1440 pixels wide by 733 pixels high.

3. Expand the grid layer in the Layers panel. Click on the Eyeball icon next to 
the GRID OVERLAY layer to hide it. Press the Command key while clicking 
on the icon of the Shape 1 layer to select the red shape defining the main 
content area of the page (FIGURE 13.9).

4. Choose the Window menu > Info to see a width and height value for the 
selected area in the Info panel. Notice that the main content has been 
developed for a width of 960 pixels (Figure 13.10).

5. Deselect the shape layer (press ⌘-D) and make the GRID OVERLAY layer 
visible again. Notice that even in web or interactive media design, the grid 
is an essential tool for organizing content. The grid overlay provides equal 
divisions within the 960-pixel width. The designer used this information to 
align content on the page.

6. Collapse the grid layer group and make it invisible. Locate the firefighter 
image—it’s inside the group homeimage-text. The original designer didn’t 
name the layers in a way that makes navigating the file simple. The fire-
fighter is named Layer 31. Notice that the photograph is clipped to a shape 
layer beneath it. Unclip and then reclip the layer to see the effects of the 
clipping group by pressing the Option key while clicking directly on the 
line between the layers. The clipping group keeps the layer sized precisely 
for the design of the interface.

SCREENCAST 13-1 FINDING SPECIFICATIONS IN 
PHOTOSHOP TEMPLATE DOCUMENTS

I’ve created a much simpler template for you to use by eliminating many of the layer 
groups present in the original template. This additional screencast is available for 
those who’d like to watch my process as I navigate through the original template.

All screencasts are available on the companion website, www.digitalart-design.com, or on the 
YouTube playlist, www.youtube.com/playlist?list=PLAy6P5IoEjy2v3kZKCt8spqJ50nLb2XQI.

When you create content 
for the screen, it’s more 
accurate to speak of 
pixels per inch than dots 
(which refers to printer 
ink) per inch. 72 DPI and 
72 PPI refer to the same 
file resolution. 

See Chapter 8,  
Exercise 8, Step 7 for 
more information on 
clipping groups.

If the Info panel displays 
units other than pixels, 
changing the units 
associated with your 
document to pixels will 
force the panel to display 
measurements in pixels. 
The easiest way to do this 
is to turn on the rulers 
(⌘-R) and then right-
click or Control-click 
directly on the ruler area 
and select the unit of 
measurement.

FIGURE 13.8 Don’t worry 
about updating text layers 
since you won’t be altering 
text in Photoshop.

FIGURE 13.9 Command-click 
on a layer’s icon to select 
the layer.

FIGURE 13.10 View the width 
and height values in the 
Info panel. Change the 
units of measurement in 
the Preferences menu.
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EXERCISE 

3 SAVE A JPG FILE FOR THE WEB

The template is a place where you can see how the page is expected to display 
in the browser (based on the code). However, you don’t need to alter the 
template in order to alter your web page. Instead, you can simply replace the 
graphics that appear in the images folder with new files that you’ll refer to in 
the code. Since the header background image is a photograph and it includes 
a layer mask with a fade to a solid color, it makes sense to compress it in JPG 
format for the web.

1. Open the file bg-featured-home.jpg from the images folder in your chap-

ter13 folder. This file is used as the header background image on the home 
page. Also open sodajerk-original.jpg in Photoshop. Press Command-A to 
select the entire contents of the document and then press Command-C 
to copy the selection. Click to the bg-featured-home.jpg image and press 
Command-V to paste the soda jerk into the firefighter image.

2. Name the new layer sodajerk. Use the Move tool to align the soda jerk with 
the left edge of the document. I also nudged the top of the document up by 
about 10 pixels to eliminate the negative carrier frame because I thought it 
would interfere with the sharp lines of the interface design (FIGURE 13.11). 

3. Add a layer mask to the sodajerk layer. On the mask, use the Gradient tool 
set to white in the foreground color and black in the background color. 
Draw a straight line from near the right edge of the image to a point before 
the right edge of the image ends (FIGURE 13.12). The image should fade out 
on the right side (FIGURE 13.13). You can redraw this gradient line until the 
fade produces your desired effect.

4. Double-click the background layer to unlock it and name it blue. Move the 
blue layer to the right while pressing the Shift key until the firefighter dis-
appears and only the blue background is visible. You may need to redraw 
the gradient on the sodajerk layer mask (FIGURE 13.14).

5. Save the file in native format (.psd). Press ⌘-Shift(⇧)-S to access the Save 
As menu. Name the file bg-featured-home-soda.psd and save it in the psd 
folder inside the chapter13 folder.

6. Now that the native file is saved in Photoshop format, save a compressed 
copy of the original as a JPG for the web. Choose the File menu > Save for 
Web (or press Command-Shift-Option-S). You can view just the compressed 
file or use one of the tabs on the top left of the dialog box to show two-up 
or four-up. (I prefer the four-up view because this allows me to do a 
comparison between my compressed file and the original). On the top-
right side of the dialog, use the compressor presets to choose between JPG 
High and JPG Medium. Choose one of them and inspect your compressed 

IMAGE CREDIT The photo 
you’ll be using is Soda 
jerker flipping ice cream 
into malted milk shakes 
(seen in screenshots 
throughout this section). 
Corpus Christi, Texas. 
Created by Russell 
Lee in February, 1939. 
Reproduction Number; 
LC-DIG-fsa-8b37302, 
Call Number LC-USF34- 
032264-D [P&P].

FIGURE 13.11 The soda jerk 
image is positioned in the 
Photoshop file.

FIGURE 13.14 The blue 
background layer is moved 
into position.

FIGURE 13.12 A white-to-black gradient is being created on 
the sodajerk layer mask.

FIGURE 13.13 Once the gradient is added to the mask, the 
image fades from the white area of the mask to the black 
area (in this case, from left to right).
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image. Then choose the other. If you see no great difference, use the more 
compressed image. (It will offer the smallest file size and the quickest 
download time.) I selected JPG Medium.  
 
Before pressing the Save button, check the Progressive box (FIGURE 13.15). 
JPG images can be saved with optimized (or baseline) compression or with 
progressive compression. The advantage of progressive compression is 
that it downloads in stages, so a user (especially one with a slow internet 
connection) perceives a faster download time because at least something 
appears to be happening.

7. Press the Save button and save the file as bg-featured-home-soda.jpg in the 
images folder > chapter13 folder.

8. After you’ve saved the image in both PSD and JPG formats, close the 
document. You won’t need to save the file again.

EXERCISE 

4 SAVE A PNG FILE FOR THE WEB

In this exercise, you’ll create a logo based on the template image on the 
top-left corner of the page, the standard position for a logo on a commercial 
website. It generally stays in the same place throughout the site and links back 
to the home page. Your logo will be made in a similar style, but instead of 
“FAYAFAYTA,” yours will read “FLAVAHH.”

1. Open the file logo.png from the images folder. Notice that the PNG file 
has a transparent background. To work on the file in a manner that will 
help you see the text, create a new layer named black, fill it with black, 
and position it at the bottom of the Layers panel. Also rename Layer 0 to 
original.

2. Save the native file as logo-modified.psd in the psd folder inside the 

chapter 13 folder.

3. Find a typeface that’s similar to the original. Notice that it’s a thick, bold 
sans serif form with rounded corners. Put any color in the foreground color 
chip so you can see your type on top of the preexisting logo. (I used red.) 
Choose the Type tool, add the word “FLAVAHH,” and make it about the 
same size as the word beneath it (FIGURE 13.16). I used Helvetica Rounded 
with the variation Black Oblique at 36 points.

FIGURE 13.15 The Save for 
Web dialog box with JPG 
options.

YIKES! Be careful of 
where you save your 
files! Be sure to save the 
compressed files in the 
images folder and the 
native files in the psd 
folder. This means that 
when you save a file for 
the web, you’ll have to 
navigate outside of the 
psd folder to find the 
images folder in the root 
directory.

FIGURE 13.16 The Character 
panel displays type settings 
for the FLAVAHH layer.

KEY COMMAND To 
complete the first 
step, I double-clicked 
Layer 0 and renamed it 
original. Then I pressed 
the Command key while 
clicking once on the 
Create a New Layer icon 
in the bottom of the 
Layers panel. Finally, I 
pressed Option-Delete to 
fill the new layer with the 
foreground color (black). 
Pressing Command-
Delete fills with the 
background color chip.

JPEG “LOSSY” COMPRESSION

JPEG is the acronym for Joint Photographic Experts Group, although files compressed 
using this method are widely referred to by the three-letter standard JPG (.jpg). This 
type of compression is valuable because it can save millions of colors, capturing 
subtle shifts in tonalities in small file formats. However, the results of JPG compres-
sion are considered “lossy,” meaning that the file will lose some of its pixel data (and 
therefore, colors) in a manner that does not allow the designer or artist to control 
which colors are lost. JPG compression does not support transparency or animation. 
It tends to create a lot of noise or visual artifacts in areas of sharp contrast. For this 
reason, it is not a recommended compression format for text or vector illustrations.
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4. Create a selection around the logo mark (the parallel lines to the left of the 
word) with the Rectangular Marquee tool. Click to make the original layer 
active. Then press the Add Layer Mask icon at the bottom of the Layers 
panel (FIGURE 13.17). The mask will show the selected area (the lines on 
the left) and hide whatever was not included in the selection (the word 
FAYAFAYTA). 

5. Activate the type layer and kern the word FLAVAHH if you need to by 
inserting the Type tool between two letters and pressing Option-← or 
Option-→ on the keypad.

6. While the type layer is active, press the letter D on the keypad to reset the 
foreground and background color chips to black and white, respectively. 
Press Command-Delete to fill the FLAVAHH layer with white.

7. With nothing selected, add a layer mask to the FLAVAHH layer. Press the 
letter G on the keyboard to activate the Gradient tool. Set the Gradient tool 
Opacity value to 55% in the Options panel at the top of the application 
window. On the layer mask, draw a gradient that starts a little below the 
bottom of the document and ends before you reach the top of the letters 
(FIGURE 13.18). If the fade isn’t quite what you expected to see, you can 
redraw the gradient or unlink the mask from the content on the Type layer 
and move the mask up or down with the Move tool.

8. Press Command-S to save the native file.

9. Click once on the Eyeball icon next to the black layer to make it invisible. 
The logo will again be set on transparency.

FIGURE 13.17 The Add Layer 
Mask icon is used to add a 
mask based on a selection. 
Notice how the selected 
area is represented on the 
mask in white, and the rest 
of the mask is black. 

See Chapter 8 for more 
details on creating and 
manipulating layer 
masks.

FIGURE 13.18 LEFT SIDE: A 
view of the Layers panel 
with the gradient in place 
on the FLAVAHH layer. 
RIGHT SIDE: Option-click on 
the mask to view just the 
mask. Here you can see 
how the gradient is drawn. 

10. Press Command-Option-Shift-S (Control-Alt-Shift-S on a PC) or choose the 
File menu > Save for Web.

11. Choose the preset PNG-24 from the top-right pull-down menu and check 
the boxes to include Transparency and Interlaced, which is similar to 
Progressive mode in JPG compression (FIGURE 13.19). Then press the Save 
button. Name the file logo-modified.png and place it in the images folder 
inside the chapter13 folder.

EXERCISE 

5
INSERTING AN IMAGE TO THE HTML CODE 
IN DREAMWEAVER

In Chapter 14, you’ll learn how to use Dreamweaver to modify the HTML and 
CSS code files included in the template. As a preview, you’ll simply adjust the 
home page, index.html, in this final exercise to swap the logo image.

1. Open Dreamweaver. If you see the Welcome Screen upon launching the 
application, close it by pressing the red X in the top-left corner of the 

FIGURE 13.19 The Save for Web 
dialog box with PNG settings.

SCREENCAST 13-2 ANIMATING A GIF

Creating an animated GIF could be a lengthy set of exercises in its own chapter. Since 
you’d have to make repairs to the original image before animating the scoop of ice 
cream, it would likely take a beginning student a couple of hours to do this from 
start to finish. However, just using the Timeline panel to create the animation itself is 
pretty simple. My repairs file, as well as a link to the ice cream image I used, is avail-
able on the companion website if you want to skip ahead to the new part of the video 
and learn to animate a file and save a GIF image.

All screencasts are available on the companion website, www.digitalart-design.com, or on the 
YouTube playlist, www.youtube.com/playlist?list=PLAy6P5IoEjy2v3kZKCt8spqJ50nLb2XQI.
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dialog box. Choose the File menu > Open and double-click index.html from 
the chapter13 folder on your Desktop.

2. Select the Designer workspace, either by selecting it from the pull-down 
menu at the top-right corner of the Application Frame or by choosing the 
Window menu > Workspace Layout > Designer.

3. Press the Split button in the top left of the Document Toolbar, beneath the 
tab labeled index.html (FIGURE 13.20). The three buttons—Code, Split, and 
Design—will change the appearance of your document as a work file that 
shows just the source code, or a split window showcasing the code and 
what the design might look like in a browser, or just the design of the page 
as it would likely appear in a browser. In split viewing mode, the source 
code appears on the left side of the Application Frame, and the design of 
the layout can be modified on the right side of the Frame.

4. In the design area, click once on the logo graphic. You’ll notice that when 
something is selected in design view, the code that generates that element 
is also selected in code view (FIGURE 13.21). The code is what controls the 
design, so the simple task of highlighting code or activating elements in 
the design area essentially refers to the same concept. Notice the code 
that’s used to add image content to an HTML source file. It’s a tag named 
image, img, with an attribute specifying the source, src. This line of code is 
responsible for the logo image: <img src=“images/logo.png” alt=log”> 
The code could be interpreted as follows:

“Place an image at this location within the page. The image can be found in 
a folder (directory) named images. The name of the image is logo.png. An 
alternative, text-based label for the image is log.”

5. The designer of this template made a typo, as “logo” should probably have 
been the alternative text. Adjust that now by simply adding the letter o at 
the end of log in the alt area of the image source tag.

6. Now swap the logo! Do you remember what you named the logo? If yours 
is like mine, newly created media file names were appended with “-modi-
fied.” So the new code would simply point to the image as images/logo-
modified.png (FIGURE 13.22).

7. Check your work in a browser. It’s always a good idea to see how your 
modifications will look in their final destination (in this case, a web 
browser). Choose the File menu > Preview in Browser > (select the browser 
of your choice). In the browser, you’ll notice that the only change you 
made so far is the logo (FIGURE 13.23).

8. Voila! It’s that easy. Well, sort of. It’s that easy when you know that you 
need to use exactly the same pixel dimensions, save the files in the appro-
priate formats, and know where to look in the code to make modifications. 
You’ll learn more about that in the next chapter.

FIGURE 13.20 The Split but-
ton in Dreamweaver lets 
you “split” your view of the 
file, including a view of the 
code and the page design. 

FIGURE 13.22 The swapped 
image appears when the 
new file is referenced in 
the code. 

FIGURE 13.23 A view of the 
web page in the browser. 

FIGURE 13.21 The image ele-
ment in code view, <img>, 
is used to reference an 
image on the page.

Dreamweaver tends to 
display the web page 
somewhat inaccurately 
in design view. As a rule, 
I don’t completely trust 
what I see in design view 
and always check my 
work in a browser.
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9. Press Command-S to save the file. You’ll save the file index.html on top of 
itself as you modify HTML documents in Dreamweaver. Don’t worry—you 
can always download the template (or my modified template) anew.

LAB CHALLENGE

Understanding the differences between JPG and PNG compression is 
important. Imagine that you’re curating a virtual gallery exhibit. The works 
can be drawings, photographs, digital art, vector illustrations, photos of 
sculptures, or anything else you can imagine. Develop a theme, find source 
images (either from friends or the web), and then resize and compress each 
image as thumbnail and large-format images to share online. The thumbnails 
will be much smaller in scale than the large-format images. The large images 
probably shouldn’t be much more than 500 or 600 pixels wide.

334  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD


